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1 INTRODUCTION

This document is a set of recommendations to the uDIG application workflow.
These recommendations are gathered from several sources:

e A series of user tests

e Community requests

¢ Product demonstrations

This document presents workflow recommendations as a series of Tasks, similar
to those already existing in online help. By structuring recommendations in this
way we are assured of keeping workflow description in user terms.

We have focused on two areas:
e First time use, including download and installation and “first impressions”
e Ongoing use

The test plan, and user experience used to produce these recommendations is
provided at the end of this document.

1 GeoConnections
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2 INSTALLATION

2.1 Windows Installation
Installing the application:

1. Download the uDig installation file from: http://udig.refractions.net

2. Download the executable

3. Double click on the installer.

2.2 Linux Installation
Installing the application:

1. Download Java 5.0 JRE by following the download links on the
http://udig.refractions.net page.

2. Install Java 5.0

3. Download Java Advanced Imaging by following the download links on the
http://udig.refractions.net page.

4. Install Java Advanced Imaging.

S. Download Java Advanced Imaging Image 10 by following the download
links on the http://udig.refractions.net page.

6. Install Java Advanced Imaging Image IO.

7. Set the environment variable JAVA_ HOME to indicate the Java install
directory.

Example: export JAVA_HOME=/usr/java/jrel.5.0

8. Download the eclipse RCP 3.1 M4 application by following the download
links on the http://udig.refractions.net page.

9. Unzip the file into a directory.
10.Download uDig from http://udig.refractions.net.

11.Unzip into the eclipse directory.

GéoConnexions
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3 FIRST TIME USE

3.1 Starting UDIG

1. Select uDig from the program files menu

2. The splash screen will be shown as the application loads

Figure 1 - Application Startup

3.2 Seeing Something on Screen
1. User selects “Show Me” from the Welcome page.
2. The sample project will be opened.

Notes: The sample project should be made up of local, indexed shapefiles and
raster files to ensure a good first impression.

3.3 Opening the Getting Started Tutorials

1. When uDig first starts up you are presented with the welcome page
2. Press the “Getting Started” tutorial button.

Alternately:

1. Choose Help from the menu

GéoConnexions
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4 WORKING WITH PROJECTS

4.1 Creating a Project

1. New

2. Choose “New Project”

3. Provide a location and name for your project

Note: You may use Browse to locate a specific directory for your New Project.

Note: If a project already exists in that location you will be prompted to replace or
cancel.

4.2 Renaming a Project
1. Right click on a project
2. Select the Rename menu item

3. Enter the new name

4.3 Exporting a Project for Others

1. Export

2. Choose Export “Project for Others”

3. Project will be exported as a zip file with all relative data included.

Note: If your project does not include any local data, it may be emailed directly.

4.4 Creating a Map
1. New
2. Choose “New Map”

3. Enter Name, and optionally CRS. Location will be based on currently selected
project.

Note: You may choose a project from the list, or use the Browse button to locate
a project on disk. You may also create a new project for your Map.

GéoConnexions
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4.5 Using Save As with an Untitled Map

1. When working with an Untitled Map save is unavailable; pressing Control-S
will bring up the Save As Dialog, or you may select it from the File menu

2. The Save As Dialog asks you to choose a Project from the list of open projects,
and supply a name.

Note: You may also use the browse button to locate a Project or create a new one.

4.6 Adding a Map to a Page
1. Create a New Map Box from the menu or tool bar.
2. A new empty Map box will be created, with an Empty Map of the same name.

Note: You may also drag an existing Map onto your empty Map Box. This will
update or replace the configuration of Layers.

4.7 Creating a Page
1. Choose Add Page from the toolbar or menu
2. Choose a template

3. Depending on the template you may be asked to supply a default Map; please
choose from the list. The current Map will be selected by default.

4. A new Map box will be added to your page, an untitled Map will be created
and can be seen in the Projects view

S. Open the Map from the Projects view, or from your Map Box

Note: You can quickly provided content for your Map by dragging an existing Map
onto your Map box. A dialog will pop up asking you if you would like to replace
any existing contents.

4.8 Creating a Page from a Map

1. Use the New Page wizard; the current Map will be used by the default
Template.

GéoConnexions
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5 WORKING WITH LAYERS

The concept of a layer shows up in several areas of our application. We intend to
keep the user interface ideas consistent, even though a layer returned by a web
search is implemented differently then a layer available in the Layers View.

Here are the things considered Layers for the purpose of this document:
e Layers available in the Layers View; these may be seen in the current Map
e Spatial resources returned via a Catalog Search
¢ File URLs identified to be Spatial Resources

Many of these recommendations make use of drag and drop, and layer will be
considered to be any of the above.

5.1 Adding a Layer to the current Map
1. From the Layer context menu choose “Add to current Map”.

Note: You may also Drag and Drop the layer onto the current Map.

5.2 Adding a File or URL to the current Map

1. Drag a File or URL onto the current Map

2. The Layer will be added on top of the existing layers

Note: The file types are limited to those supported by the Import wizards.

5.3 Adding a Layer to the Layer View

1. Drag a File or URL onto the Layer View

2. The Layer will be inserted in the order indicated by the drop location.
Note: The file types are limited to those supported by the Import wizards.

5.4 Working with Spatial Operations

1. Locate the layer you wish to work on

2. From the Tools menu select Spatial Operations Wizard
3. Choose the Operation from the available categories

4. Each operation has its own Wizard.

Note: Common operations are often available on the context menu.

GéoConnexions
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5.5 Generating Content

1. Choose the Spatial Operation from Tools menu or layer context menu.
2. Follow the wizard’s instructions

3. The last page of the wizard will allow you to specify a result location

e By default a Temporary Layer is used. You may export this Layer to any
Service at a later time.

¢ You may choose a Service using the Export Layer Wizard Pages

¢ A checkbox, on by default, allows you to add the produced layer to the
current Map.

4. The progress view or the layer’s context menu can be used to cancel the
operation.

5.6 Creating a New Map from a Layer

1. Drag a file or URL onto the Empty uDig editor area, or onto a Project in the
Project View.

2. A new untitled map will open containing that shapefile.

Note: The file types are limited to those supported by the Import wizards.

5.7 Adding a Layer to another Map
1. Drag and Drop a Layer to the Map in the Project’s view

5.8 Exporting a Layer
1. From the Layer context menu choose “Export to Service”

2. The export wizard asks you to choose a Service. You may also ‘Search’ or
‘Browse’ to locate the correct service.

3. The service ‘Save As...” also appears in the list; choosing this allows you to
export to the file system.

Note: You may also export a Layer by Dragging a Layer onto the Service, or into
the Service editor.

Ve ReRfractlons -10 - e
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5.9 Exporting a Layer to the File System

1.
2.

From the Layer context menu choose “Save As”

You may browse for the correct location and choose from the available
formats.

Depending on the export format you may need to supply additional
information such as raster resolution

Note: When replacing an existing layer, you will often be asked to confirm. Not all
servers support the concept of completely overwriting an existing layer.

Note: You may also export a layer to the file system by dragging it onto the File
System view.

5.10 Working with Temporary Layers

1.

Temporary Layers act in a manner similar to untitled Maps.
They are often produced by spatial operations and may be seen in the Catalog
view. Temporary Layers can also be added to a Map in the normal manner.

At any time you may choose to export these layers to a Service, or save them
to the file system. At this time any Maps making use of the temporary layers
will be updated.

5.11Saving a Project with Temporary Layers

1.

Temporary Layers act in a manner similar to untitled Maps.
They are often produced by spatial operations and may be seen in the Catalog
view. Temporary Layers can also be added to a Map in the normal manner.

. When saving a project that contains temporary layers, you will be asked to

choose which layers you wish to save. All temporary layers used by your map
will be checked by default.

. The Project Save wizard will walk you through saving each individual layer

using a series of Export Layer wizard pages.

Ve ReRfractlons - 11 - e
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6 WORKING WITH CATALOGS AND SERVICES

The concept of a service shows up in several areas of our application.
Here are the things considered Services for the purpose of this document:
e Services available in the Catalog View
e Services returned via a Catalog Search
e URLs identified to be Services, often GetCapabilities or JDBC URLs

Many of these recommendations make use of drag and drop and Service will be
considered to be any of the above.

6.1 Creating a Map from a GetCapabilities URL
From a WMS or WFS Layer:

1. Choose “New” from the file menu

2. Choose “New Map from GetCapabilities” from the list

3. Provide the URL in the field provided, the clipboard will be checked for a
valid default value

4. Use the Select Layers page to choose which layers to include.
S. An untitled Map will be created, with the indicated layers added.

Note: You may also drag and drop a GetCapabilities URL onto the Map editor,
and start from the Select Layers page.

Note: If the number of layers is large, all the layers will be unselected by default;
if the number of layers is less then 10, they will all be selected. By default only
the top WMS layer is selected.

Ve ReRfractlons -12- e

Canadi



6.2 Creating a Map from a JDBC URL

Although JDBC URLs will not display in a browser, they do provide a way to
email database connection information.

1. Choose “New” from the file menu
2. Choose “New Map from Database” from the list

3. Provide the JDBC URL in the field provided, the clipboard will be checked
for a valid default value

4. Use the Select Layers page to choose which layers to include.
S. An untitled Map will be created, with the indicated layers added.

Note: You may also drag and drop a GetCapabilities URL onto the Map editor,
and start from the Select Layers page.

Note: If the number of layers is large, all the layers will be unselected by default;
if the number of layers is less then 10, they will all be selected. By default only
the top WMS layer is selected.

6.3 Import a GetCapabilities URL
1. Drag a GetCapabilities URL onto uDig

2. The Catalog View will open and your newly created Service or Catalog Service
will be selected.

6.4 Searching for Services

1. In the search view, enter a string of text that is relevant to the service you
wish to search for. Press enter or the ‘go’ button to begin the search.

2. The results will appear below the line with services on the left.

3. Select a service to display the relevant resources on the right.

GéoConnexions
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7 WORKING WITH MAPS

7.1 Identify

1. Select the info tool from the tool bar while a map is open. You may also open
the Info View and select the info tool from the toolbar. When working with a
Map the 9’ keyboard shortcut may be used.

2. Locate a point on the map and click.

3. The Info View will be updated with a list of all “hits” indicating available
information at that location.

4. Choose the ‘Hit” from the list, and the content will be displayed on the right

Note: Information content ranges from actual Feature information to generated
web pages.
1. Web Pages: Use the provided browser to read the page and navigate any
provided links, the Home button will return you to the original content.

2. Features: Use the provided table to navigate through the available
information. You can switch to the Feature Editor at any time.

3. XML and Errors: XML documents are displayed in tree form, often XML
documents are used to report errors

4. Images: Images are occasionally returned, sometimes with a rendered
error message. They will be displayed in an embedded browser.

Note: A “hit” represents when the request is made; the associated layer may have
been changed, or even removed at any time after your info request.

Ve ReRfractlons -14 - GeoChrnagtions
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7.2 Map Navigation with Zoom and Pan

1.

Choose Zoom or Pan from the menu or tool bar.
You may also choose Z’ or ‘p’ to select the associated tool.

. Clicking on the map with the Pan tool and dragging the mouse will pan the

map in the direction of the drag.

Clicking on the map while holding the alt button and dragging the mouse will
pan the map in the direction of the drag.

Left clicking on the map with the Zoom tool and dragging the mouse, thus
drawing a rectangle, will zoom into the area selected.

Right clicking on the map with the Zoom tool and dragging the mouse,
drawing a rectangle, will fit the current view in the drawn rectangle, resulting
in a zoom out.

6. Turn the mouse scroll wheel forward to zoom in.

7.

Turn the mouse scroll wheel back to zoom away.

7.3 Printing a Map

1.

While a map is open press the print button. Alternatively you can right click
on a map and select print. (Perhaps this should be ‘create a page’, rather than
‘print’, because that is what is really going on here.). The page editor will
open, prompting with a dialog to select a template. If there is only one
template it will default to it automatically.

From the page editor push the print button and it will print.

7.4 Adding a layer to a Map

1.
2.

Drag a layer from the layers view to a map in the projects view.

Drag a layer from another map that is expanded in the projects view into
another map.

Drag a service or a resource from the catalog view into the current map, or a
map in the projects view.

Ve ReRfractlons - 15 - e
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7.5 Re-ordering Layers

1. Select a layer in the layers view and either press the up or down buttons to
move it in the list, or drag it to the desired position.

7.6 Deleting a Layer from a Map

1. Select the layer from the layers view or the projects view and select delete.

7.7 Reprojecting a Map
1. In the project explorer right click on a map and select properties.

2. Select a new projection system and press OK.

7.8 Reprojecting a Layer

1. In the project or layers view right click on one or more layers and select
properties.

2. From there you can change the coordinate projection of all the selected layers.

7.9 Changing Layer Appearance

1. Open the style view by right clicking on a layer in the Projects view or the
Layers view.

2. In the styles view choose the type of style you would like to edit. Edit it.
3. Press the apply button.

r ReRfra C t i ons - 16 - GeoConnections
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8 WORKING WITH EDITING AND SELECTION

8.1 Editing a Feature’s Geometry
1. Select the feature edit tool while a map is open.

2. Click on a vertex to select the vertex. Multiple vertices can be selected by
holding down control or shift. A vertex can be unselected by clicking on a
vertex while holding control.

3. Drag a single vertex or a set of vertices to move the selection.

4. Press the delete key or select delete from the context menu to delete the
selected vertices.

8.2 Drawing a New Feature
1. Click somewhere on the map to create a vertex.

2. Click again to create another vertex that will be connected to the most
recently created vertex.

3. Deselect the edit tool when you are done creating the new feature.

8.3 Deleting a Feature
1. Select a feature using the feature select tool.

2. Right click on it and select delete or press the delete key on your keyboard to
delete the feature.

8.4 Viewing the Attributes of a Feature
1. Select the feature select tool while a map is open.

2. Right click and select properties. The Properties view will open. All of the
feature’s attributes will be listed there.

3. If multiple features are selected, it is possible to set attributes in all of the
features at one time.

8.5 Editing the Attributes of a Feature

1. Click on an attribute in the Properties view to activate an attribute editor

2. Use the attribute editor to set the value.

8.6 Committing a Transaction

1. Press the commit button or select the commit menu item to commit all the
changes in the current transaction.

r Re fracti ons - 17 - GeoConnections
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8.7 Canceling a Transaction

1. Press the rollback button or select the rollback menu item to cancel all the
changes in the current transaction.

GéoConnexions
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9 WORKFLOW TEST PLAN

This is the test plan used to perform workflow reviews.

We are focused on several areas of the user interfaces that require feedback:
e Apply/Cancel workflow used by the Style Editor
e Commit / Revert workflow used for transaction control
e Data discovery and Map creation
e Page Layout

The screen snapshots included with the test plan have been carefully
constructed and will require the use of the Style View, and a change of
Projection.

We have chosen a representative set of users covering the following areas:
e GIS Expert — familiar with GIS concepts
e Developer — eclipse developer, unfamiliar with GIS application

¢ New User — new to the GIS domain, unfamiliar with common concepts
such as Features

GéoConnexions
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10 UDIG WORKFLOW TESTING

1. Download and install the uDig from our website: http://udig.refractions.net

2. Set-up Map with the following content and appearance:

WMS http://www2.dmsolutions.ca/cgi-bin/mswms

map?VERSION=1.1.0&REQUEST=GetCapabilities

Shape | http://udig.refractions.net/downloads/sampledata/cntry00.shp.zi

=10 x|
File Edt - Layer Window Help
I I | b0 b +|dien | o|a|xd
2 projects £1 > Ll

T Layers £ o4 =g
 park
i@ Scalebar
bathymetry
L@ ontryno

Propertes |G Catalog £1

[ land_fn =
@ park =
[ dran_fn

@ dranage il
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3. Print your map with the following layout.

Test Plan Map

0 222722 445444 668166 890889 1

4. See if you can answer the following question:
What is the population of Victoria, Canada?

5. Perform a simple change:

Change Canada’s nation currency.
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11 USER EXPERIENCE

11.1GIS Expert

Our GIS expert represented someone familiar with similar products such as
JUMP or ArcView. Overall, the user found the experience quite frustrating and
spent most of the time exploring the file menu and new wizards. The test was cut
short due to technical difficulties.

11.1.1 Unnoticed EXxisting Features
e Missed drag and drop entirely.
e Did not discover any of the extra views such as Catalog.

e Took a long time before the import wizards were noticed.

11.1.2 Expected Features

e Expected the import wizards to create and open a map, or at least give
some indication of success.

11.1.3 Positive Features

e Installation went as expected.

11.1.4 Areas of Difficulty

e Extreme difficulty in initially creating a map. The lack of any initial data or
projects seemed confusing, coupled with the fact that these actions could
not be performed from within the wizard itself.

e Was confused by the New Project Wizard’s browse function. The browse
window states “Open”, indicating the wrong function.

¢ Confused that the map tools were disabled while the map was open but
not selected.

e Confused by inability to create a feature.
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11.2Eclipse Developer

Our developer represented an experienced Eclipse user, unfamiliar with GIS
applications.

A generally positive experience, primary mode of application discovery was
searching for context menus. Would occasionally run off to try and break the
application with large datasets rather than follow the test plan.

11.2.1 Unnoticed Existing Features

e User did not bother looking through the menus for functionality.

e Unable to change a Map to an alternate projection. Looked in the properties
view and found WKT and was unwilling to edit. Did not discover the
properties editor with GUI for editing the same.

11.2.2 Expected Features

e Expected a great deal more context menus. Indeed this was the user’s
primary method of application discovery. If it had an Icon he tried right
clicking on it.

e Expected to be able to draw a bounding box with the info tool, suggested a
change to pointer

¢ Guessed that the “Commit” button was used to start editing, commit button
lacked tool tip and should have been disabled.

e Expected a single click to edit Title in Page Editor, user clicked wildly
expecting feedback

11.2.3 Positive Features

Installation went as expected

Found import button promptly

Able to add scalebar, was not visible until correct zoom level was reached
Was able to work with a large 250 meg shapefile

Was pleased with scrollwheel zooming.

11.2.4 Areas of Difficulty

e Importing a WFS resulted in a WFS labeled WMS. This confusion is due to the
server, but a more distinct icon, or service type in brackets may help.

e New Project wizard did not replace a previously created project.

e Was startled at the addition of a fill colour when using the Style view border
control to edit the current style.

e Impatient for tool tips to show up on toolbar, user did not attempt to use the
menus but would often scrub the toolbar for tool tips to discover
functionality.
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11.3New User

The user had little to no previous GIS experience and had never used a GIS
application previously. The user was a software developer with experience with
programs such as Paint Shop. The user discovered functionality by:

1. Looking through all menus
2. Searching through the main toolbar looking at their tool tips.
3. Searching through all the views looking at their buttons.

Another common behaviour was to right-click on items to discover what
operations can be performed on the item.

11.3.1 Unnoticed EXxisting Features

e Drag and Drop

o Although once discovered drag and drop was used extensively.
e Had difficulty determining how to zoom out.

o Scroll zoom was rarely used.

o Right click was not appreciated because it did not have enough effect,
the default should make a larger change.

e Pan tool

o The pan tool was never discovered, it is likely that the icon and tool-tip
should be changed. A hand seems a likely alternative.

e The icon and tool-tip of the Zoom-To-Extent tool was not sufficient for the
user to understand its purpose without using it.

e The view menus were never noticed.

e The Selection tool was not noticed at first because the user expected the info
tool to be a selection tool as well. The icon did not differ sufficiently to convey
the difference in functionality.

11.3.2 Expected Features

e Wanted double-clicking to perform some action in all views.

e User expected to be able to shift-click in multiple areas to obtain a
compilation of multiple info responses.

e The user expected to be able to draw a rectangle with the info tool and obtain
info of all features in that area.

11.3.3 Positive Features

e Made use of context menus extensively.

¢ Once drag and drop was discovered the feature was used extensively.
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11.3.4 Areas of Difficulty

At first the user didn’t realize that data could be dragged into the edit area
and a map would be created. So the New Map Wizard was used.
Unfortunately the New Map Wizard requires that a project exist. This caused
a problem for the user.

Editing tools are disabled when the editor is not active, even though the editor
may be showing. The user had a very difficult time realizing that the editor
had to be selected before a new tool could be activated.

During Page Layout the user did not know that the box with the title
“Decorator” indicated the scalebar that was part of the map.

The user expected to have to add the scalebar to the page layout, not to the
map and then moved around in the page layout. The map was expected to be
printed exactly as shown.

Didn’t expect to have to press print again to print the page.

Didn’t understand that one of the info objects in the info list had to be
pressed in order to obtain the summary.

The user was unable to determine how to change the projection of a map.
The user had difficulty determining how to open new views.

11.3.5 General Suggestions

New Map Wizard should permit new projects to be created.
The WMS requests do not show any data until the request is fulfilled and do
not convey strongly enough that something is happening.

1. There should be a way for the renderer to indicate that it does not
provide continuous feedback.

2. Further, although this is more technical, the renderer must yield its
execution time slice if it is simply waiting for a response. This will
improve performance of other renderers.

Editor tools should always be available when an editor is open and visible.
Page Editor should either have a print button within it or a different button
should be used to create a Page.
Information tool should:

1. display a summary of the obtained data automatically;

or
2. instructions on how to view the info should be displayed

In order to make drag and drop a more obvious option a default, empty map
should exist in a default project.

The vertex manipulation tool should have a special mouse cursor to indicate
that vertices can be placed.

The Properties and Selection views and possibly the Info view should be
collapsed into one view or tightly integrated to work together.
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